SINAMICS S120
Getting Started

Preface

Safety instructions

SINAMICS S120 drive system

Overview

Hardware components

Creating a drive object

Configuring the drive object

Commissioning a drive

Appendix

Valid as of:
Firmware Version 4.6

01/2013
6SL3097-4AG00-0BP2
Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

⚠️ WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

SINAMICS documentation
The SINAMICS documentation is organized in the following categories:

- General documentation/catalogs
- User documentation
- Manufacturer/service documentation

More information
The following link provides information on the topics:

- Ordering documentation/overview of documentation
- Additional links to download documents
- Using documentation online (find and browse through manuals/information)
  http://www.siemens.com/motioncontrol/docu

Please send any questions about the technical documentation (e.g. suggestions for improvement, corrections) to the following e-mail address:
  docu.motioncontrol@siemens.com

My Documentation Manager
Under the following link there is information on how to create your own individual documentation based on Siemens' content, and adapt it for your own machine documentation:
  http://www.siemens.com/mdm

Training
Under the following link there is information on SITRAIN - training from Siemens for products, systems and automation engineering solutions:
  http://www.siemens.com/sitrain

FAQs
You can find Frequently Asked Questions in the Service&Support pages under Product Support:
  http://support.automation.siemens.com

SINAMICS
You can find information on SINAMICS under:
  http://www.siemens.com/sinamics
### Usage phases and their documents/tools (as an example)

<table>
<thead>
<tr>
<th>Usage phase</th>
<th>Document/tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>SINAMICS S Sales Documentation</td>
</tr>
</tbody>
</table>
| Planning/configuration | • SIZER engineering tool  
                          | • Configuration Manuals, Motors                                               |
| Deciding/ordering   | SINAMICS S120 catalogs  
                          | • SIMOTION, SINAMICS S120 and Motors for Production Machines (Catalog PM 21)  
                          | • SINAMICS and motors for single-axis drives (catalog D 31)                   
                          | • SINUMERIK & SINAMICS Equipment for Machine Tools (Catalog NC 61)            
                          | • SINUMERIK 840D sl Type 1B Equipment for Machine Tools (Catalog NC 62)       |
| Installation/assembly | • SINAMICS S120 Equipment Manual for Control Units and Additional System Components  
                          | • SINAMICS S120 Equipment Manual for Booksize Power Units                     
                          | • SINAMICS S120 Equipment Manual for Chassis Power Units                      
                          | • SINAMICS S120 Equipment Manual for AC Drives                               
                          | • SINAMICS S120M Equipment Manual Distributed Drive Technology                |
| Commissioning       | • STARTER commissioning tool                                                  
                          | • SINAMICS S120 Getting Started                                               
                          | • SINAMICS S120 Commissioning Manual                                          
                          | • SINAMICS S120 CANopen Commissioning Manual                                 
                          | • SINAMICS S120 Function Manual                                               
                          | • SINAMICS S120 Safety Integrated Function Manual                            
                          | • SINAMICS S120/S150 List Manual                                             |
| Usage/operation      | • SINAMICS S120 Commissioning Manual                                          
                          | • SINAMICS S120/S150 List Manual                                             |
| Maintenance/servicing | • SINAMICS S120 Commissioning Manual                                          
                          | • SINAMICS S120/S150 List Manual                                             |
| References           | • SINAMICS S120/S150 List Manual                                             |

### Target group

This documentation is intended for machine manufacturers, commissioning engineers, and service personnel who use the SINAMICS drive system.
Benefits

This Manual describes all the information, procedures and operational instructions required for commissioning and servicing SINAMICS S120.

Standard scope

The scope of the functionality described in this document can differ from the scope of the functionality of the drive system that is actually supplied.

- It may be possible for other functions not described in this documentation to be executed in the drive system. However, no claim can be made regarding the availability of these functions when the equipment is first supplied or in the event of servicing.
- Functions that are not available in a particular product version of the drive system may be described in the documentation. The functionality of the supplied drive system should only be taken from the ordering documentation.
- Extensions or changes made by the machine manufacturer must be documented by the machine manufacturer.

For reasons of clarity, this documentation does not contain all of the detailed information on all of the product types. This documentation cannot take into consideration every conceivable type of installation, operation and service/maintenance.

Technical Support

Country-specific telephone numbers for technical support are provided in the Internet under Contact:

http://www.siemens.com/automation/service&support

EC Declaration of Conformity

The EC Declaration of Conformity for the EMC Directive can be found on the Internet at:

http://support.automation.siemens.com

There – as a search term – enter the number 15257461 or contact your local Siemens office.

Purpose of this document

This documentation is aimed at beginners who want to find out more about the SINAMICS S120 drive system. The document offers a brief guide to commissioning a sample project with a simple SINAMICS S120 drive train. By following the instructions in this document, a beginner will need only a few minutes to engineer and configure the sample project and start up the motor.

The sample project will be processed using a SINAMICS S120 training case.
Table of contents

Preface ...................................................................................................................................................... 3
1 Safety instructions ..................................................................................................................................... 9
  1.1 General safety instructions ............................................................................................................9
  1.2 Handling electrostatic discharge sensitive devices......................................................................12
2 SINAMICS S120 drive system ................................................................................................................. 13
3 Overview .................................................................................................................................................. 15
4 Hardware components............................................................................................................................. 17
  4.1 Components of the example configuration ..................................................................................17
  4.2 System data of the SINAMICS S120 training case ......................................................................18
  4.3 Wiring the components ................................................................................................................20
5 Creating a drive object ............................................................................................................................... 21
  5.1 Overview ......................................................................................................................................21
  5.2 Setting the communication interfaces ..........................................................................................22
  5.2.1 Setting up the Ethernet interface .................................................................................................22
  5.2.2 Calling STARTER ........................................................................................................................23
  5.2.3 Assigning the Ethernet interface in STARTER ............................................................................24
  5.3 Creating a drive project ................................................................................................................26
6 Configuring the drive object ..................................................................................................................... 29
  6.1 Configuring the drive unit .............................................................................................................29
  6.2 Configuring the Motor Module ......................................................................................................33
  6.3 Special issues with the SINAMICS S120 training case ..................................................................34
7 Commissioning a drive ............................................................................................................................ 37
A Appendix .................................................................................................................................................. 43
  A.1 List of important alarms and faults .................................................................................................43
  A.2 Restoring factory settings ..............................................................................................................45
  A.3 Documentation overview ..............................................................................................................47
Table of contents
1.1 General safety instructions

**DANGER**

**Danger to life when live parts are touched**

Death or serious injury can result when live parts are touched.

- Only work on electrical devices when you are qualified for this job.
- Always observe the country-specific safety rules.

Generally, six steps apply when establishing safety:

1. Prepare for shutdown and notify team members who will be affected by the procedure.
2. Disconnect the machine from the supply.
   - Switch off the machine.
   - Wait until the discharge time specified on the warning labels has elapsed.
   - Check that it really is in a no-voltage condition, from phase conductor to phase conductor and phase conductor to protective conductor.
   - Check whether the existing auxiliary supply circuits are de-energized.
   - Ensure that the motors cannot move.
3. Identify all other hazardous energy sources, e.g. compressed air, hydraulic systems, water.
4. Isolate or neutralize all hazardous energy sources, e.g. by closing switches, grounding or short-circuiting or closing valves.
5. Secure the energy sources against switching on again.
6. Make sure that the machine is completely locked out and that you have the right machine!

After you have completed the work, restore the operational readiness in the inverse sequence.
1.1 General safety instructions

**DANGER**

**General safety notices**

- Commissioning is absolutely prohibited until it has been completely ensured that the machine, in which the components described here are to be installed, is in full compliance with the provisions of the EC Machinery Directive.
- SINAMICS devices and AC motors must only be commissioned by suitably qualified personnel.
- The personnel must take into account the information provided in the technical customer documentation for the product, and be familiar with and observe the specified danger and warning notices.
- When electrical equipment and motors are operated, the electrical circuits automatically conduct a dangerous voltage.
- When the machine or system is operated, hazardous axis movements can occur.
- All work carried out on the electrical system must be carried out at zero voltage.
- SINAMICS devices with three-phase motors must only be connected to the power supply via an AC-DC residual-current-operated device with selective switching if it has been verified that the SINAMICS device is compatible with the residual-current-operated device in accordance with IEC 61800-5-1.
- The successful and safe operation of this equipment and motors is dependent on correct transport, proper storage, installation and mounting as well as careful operator control, service and maintenance.
- For special versions of the devices and motors, information and data in the catalogs and quotations additionally apply.
- In addition to the danger and warning information provided in the technical customer documentation, the applicable national, local, and plant-specific regulations and requirements must be taken into account.
- Only protective extra-low voltages (PELVs) that comply with EN 60204-1 may be connected to any connections and terminals between 0 and 48 V.

**CAUTION**

**Danger due to high surface temperatures**

- The motors can have surface temperatures of over +80° C.
- This is the reason that temperature-sensitive components, e.g. cables or electronic components may neither be in contact nor be attached to the motor.
- When attaching the connecting cables, you must ensure that:
  - They are not damaged
  - They are not under tension
  - They cannot come into contact with any rotating parts


NOTICE

Material damage due to incorrect voltage tests

- As part of routine tests, SINAMICS devices with three-phase motors are subject to a voltage test in accordance with EN 61800-5-1. Before the voltage test is performed on the electrical equipment of industrial machines in accordance with EN 60204-1, Section 18.4, all connectors of SINAMICS equipment must be disconnected/unplugged to prevent the equipment from being damaged.
- Motors should be connected according to the circuit diagram provided, otherwise they can be destroyed.

Note

Low-voltage directive

When operated in dry areas, SINAMICS devices with three-phase motors conform to Low-Voltage Directive 2006/95/EC.
1.2 Handling electrostatic discharge sensitive devices

Electrostatic sensitive devices (ESDs) are individual components, integrated circuits, modules or devices that may be damaged by either electrostatic fields or electrostatic discharge.

**NOTICE**

**Damage due to electric fields or electrostatic discharge**

Electric fields or electrostatic discharge can result in malfunctions as a result of damaged individual components, integrated circuits, modules or devices.

- Package, store, transport and send the electronic components, modules or devices only in the original product packaging or in other suitable materials, e.g. conductive foam rubber or aluminum foil.

- Only touch components, modules and devices, if you are grounded using one of the following measures:
  - Wearing an ESD wrist strap
  - Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring

- Only place down electronic components, modules or devices on conductive surfaces (table with ESD surface, conductive ESD foam, ESD packaging, ESD transport container).
Modular system for sophisticated drive tasks

SINAMICS S120 solves complex drive tasks for a wide range of industrial applications and is, therefore, designed as a modular system. Users can choose from many different harmonized components and functions to create a solution that best meets their requirements. SIZER, a high-performance engineering tool, makes it easier to choose and determine the optimum drive configuration.

SINAMICS S120 is supplemented by a wide range of motors. Whether torque, synchronous or induction motors, whether rotating or linear motors, all of these motors are optimally supported by SINAMICS S120.

System architecture with a central Control Unit

On the SINAMICS S120, the drive intelligence is combined with closed-loop control functions into Control Units. These units are capable of controlling drives in the vector, servo, and V/f modes. They also perform the speed and torque control functions plus other intelligent drive functions for all axes on the drive. Inter-axis connections can be established within a component and easily configured in the STARTER commissioning tool using a mouse.
System overview

The SINAMICS S120 drive system consists of a variety of different modules. It is constructed of infeeds, filters, motor power units, modules for additional functions, Control Units plus standard and special versions of rotating and linear motors.
Overview

This manual provides instructions on how to commission a simple SINAMICS S120 drive based on a sample project.

To create a sample project the following points are explained:

1. Which hardware components do you need for the sample project?
2. How do you create a simple project in the STARTER?
3. How do you configure a drive?
4. How do you put the drive into operation?
4.1 Components of the example configuration

The following components are contained within the example configuration:

- CU320-2 DP from firmware version 4.5 with integrated Ethernet interface
- Smart Line Module (supply module)
- Line filter
- Double Motor Module
- Line reactor (for ALM and SLM)
- Synchronous servo motor with absolute encoder and DRIVE-CLiQ interface
- Standard PC with Windows operating system as a programming device (PG/PC), with pre-installed STARTER commissioning tool from version 4.3. The following procedure uses the Windows XP operating system. With other operating systems (such as Windows 7), operation may differ slightly.
- Installed motor, power, and control cables
- DRIVE-CLiQ cables
- Ethernet interface in the PG/PC
- Ethernet connection between the PG/PC and the Control Unit
4.2 System data of the SINAMICS S120 training case

The example configuration is performed on a SINAMICS S120 training case.

![Figure 4-1 Training case](image)

The following technical data applies to the training case used:

**Structure**

Drive system comprising:

- CU320-2 Control Unit with TB30 Terminal Board
- Smart Line Module 5 kW, Double Motor Module 3 A
- One 1FK7022-5AK71-1AG3 synchronous servo motor with incremental encoder sin/cos 1 Vpp via SMC 20
- One 1FK7022-5AK71-1LG3 synchronous servo motor with absolute encoder 2048 and DRIVE-CLiQ interface.
- Reference discs for position monitoring
The training case is supplied ready-to-use with a demo project on the memory card and documentation.

### Technical data

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree of protection</td>
<td>IP20</td>
</tr>
<tr>
<td>in accordance with DIN VDE 0470 Part 1 EN 60529/IEC 529</td>
<td></td>
</tr>
<tr>
<td>Supply voltage&lt;sup&gt;1)&lt;/sup&gt;</td>
<td>1 AC 230 V/50 Hz</td>
</tr>
<tr>
<td></td>
<td>Via power supply adapter 1 AC 115 V (USA) (not supplied in the package)</td>
</tr>
<tr>
<td>Dimensions (W x H x D) in mm</td>
<td>320 × 650 × 330</td>
</tr>
<tr>
<td>Weight</td>
<td>Approx. 30 kg</td>
</tr>
</tbody>
</table>

<sup>1)</sup> The connection conditions of the respective network operator are to be observed.

### Selection and ordering data

<table>
<thead>
<tr>
<th>Training case</th>
<th>Order no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINAMICS S120 TK-SIN-CU320-2</td>
<td>6ZB2480-0CM00</td>
</tr>
<tr>
<td>2-axis design with 1FK7 motors</td>
<td>6ZB2480-0CN00</td>
</tr>
<tr>
<td>With CU320-2 DP and demo project</td>
<td></td>
</tr>
<tr>
<td>With CU320-2 PN and demo project</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power supply adapter</th>
<th>Order no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 AC 115 V / 1 AC 230 V</td>
<td>6AG1 064-1AA02-0AA0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operator box</th>
<th>Order no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINAMICS (if ordered separately)</td>
<td>6AG1 064-1AA01-0AA0</td>
</tr>
</tbody>
</table>
4.3 Wiring the components

The components of this example are assembled and wired into the SINAMICS training case. No changes to this wiring are permitted. For the purpose of commissioning this project example, it is not permissible to connect other components or drive loads to the motor.

Figure 4-2  Wiring principle

Note

The following description only refers to one of the two motors.
Creating a drive object

5.1 Overview

This example shows how you can generate a new drive project using the STARTER commissioning tool. You then transfer the drive project via a communication interface to the Control Unit of the drive.

For data exchange between the programming device (PG/PC) and the Control Unit (CU), an Ethernet interface is used in the example, which is integrated into each SINAMICS S120 device. With PROFIBUS or PROFINET interfaces, commissioning happens in a similar way.

The programming device and the drive (in the training case example) are switched on and connected to each other via a data line.
5.2 Setting the communication interfaces

5.2.1 Setting up the Ethernet interface

For the commissioning, the programming device (PG/PC) can be connected to the Control Unit via an Ethernet interface. However, the communications interface of the programming device must first be set up.

Note
The following procedure is based on the Windows XP operating system. With other operating systems (such as Windows 7), operation may differ slightly.

Communication interface of the programming device

1. In the programming device (PG/PC) call up the control panel via the menu items "Start > Settings > Control Panel".
2. In the control panel, double-click on the "Network Connections" symbol and then double-click on the relevant network card.
3. Select "Internet Protocol (TCP/IP)", and click the "Properties" button.
4. Activate the option "Use the following IP address."
5. Set the IP address of the access interface of the PG/PC to the Control Unit to 169.254.11.1 and the subnet mask to 255.255.0.0.

![IP address of PG/PC](image)

6. Click "OK" and close the Windows-specific window of the network connections.

### 5.2.2 Calling STARTER

1. Click on the STARTER symbol of your user interface.

   Or

2. Go through the menu items "Start > SIMATIC > STEP 7 > STARTER" in your Windows Start menu.
5.2 Setting the communication interfaces

5.2.3 Assigning the Ethernet interface in STARTER

Assigning the communication interface

1. In STARTER, go through the menu items "Tools > Set PG/PC interface...".

   The "Set PG/PC interface" window opens:

   ![Creating an access point](image)

   Figure 5-2 Creating an access point

2. Check the access point of the application. Here, the access point "DEVICE (STARTER, SCOUT) ..." must be set.
   If necessary, correct the access point using the "Access Point of the Application" drop-down list.

   **Note**

   The interface in our example has the designation **TCP/IP -> Belkin F5D 5055 Gigabit USB 2.0 Network Adapter**.
   However, any Ethernet interface of the PG/PC can essentially be used.
3. If the desired adapter is in the list, continue as described in point 6. If the required adapter is not included in the list, you must add the appropriate entry. To do so, click on the "Selection..." button.

The already installed interfaces are located in the window "Install/uninstall interfaces". If the required interface is not present, you must install it yourself.

4. Select the desired interface on the left-hand side, and then click on "Install->". The interface then changes to the right-hand side.

5. Select the required interface and close the window.

6. Click in the list box "Interface parameter assignment used:" on the interface parameter assignment "TCP/IP -> Belkin F5D 5055 Gigabit USB 2.0 Network Adapter."

7. Close the "Set PG/PC interface" window by clicking "OK."
5.3 Creating a drive project

In STARTER, the project wizard will guide you through all the steps necessary to create and set up a new drive project.

Procedure

1. In STARTER, click on the menu items "Project > New with Wizard."

   The start window of the project wizard is opened.

2. Click on the "Find drive units online..." button.

   In step 1, the project wizard opens the "Create new project" window.

3. Enter a name for your project, e.g. "Sample Project", in the input field.
4. Click on "Continue >".

In step 2, the project wizard opens the "Set PG/PC interface" window.

5. In this window, you can check the settings of the communication interface made in the previous chapter, i.e. you do not have to change anything in this window. Click on "Continue >".

The project wizard searches for drive units in step 3. The drive units found are displayed in "Preview".
6. Click on "Continue >".

The project wizard continues to step 4 to display a summary of your project settings.

![Summary](image)

7. Click on button "Complete".

The project wizard closes the window.

In the project navigator, the found drive unit "S120_CU320_2_DP" is then displayed under the sample project.

![Drive object created](image)
6.1 Configuring the drive unit

In the example configuration, the "S120_CU320_2_DP" drive unit is configured for operation in the online mode. Through automatic configuration, the drive is initially switched to the "Factory settings" state and then provided with a standard configuration.

Procedure

1. Go to the menu items "Project > Connect to selected target devices" to switch to online mode.

When connecting with a target device for the first time, the target device selection is opened. The "DEVICE" option is activated as the access point.

![Target Device Selection](image)

Figure 6-1 Target device selection
2. Activate the desired target device and click on "OK."

The target device selection is closed and online mode is active.

Note

Online/offline comparison

If you create additional projects in the same way in quick succession, the "Online/offline comparison" dialog appears after closing the target device selection. This dialog indicates that the data saved in your drive object (of the training case) does not correspond with the data of the new project. The reason for this is generally because you have configured settings in the expert list in the last project that are still saved in the target device (the training case), but which are missing in the newly created project in STARTER (see section Special issues with the SINAMICS S120 training case (Page 34) and section Commissioning a drive (Page 37)).

However, as the online and offline configuration has to be identical, the data records have to be aligned.

1. To do this, click on the "Load to PG ==>" button and confirm the subsequent "Load to PG" prompt with "OK."

The "Online/offline comparison" dialog is emptied.

2. If no more differences remain, click on "Close."

In general, the settings required for the training case are then already available in the expert list (see section Special issues with the SINAMICS S120 training case (Page 34) and section Commissioning a drive (Page 37)).

3. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP".

The list of objects for this drive opens and looks like this:

![Figure 6-2 Launch automatic configuration](image-url)
4. Double-click on option "Automatic configuration" in the project navigator.

The following window opens:

![Automatic configuration window]

5. Start the automatic configuration of the drive unit by clicking on the "Configure" button.

The programming device (PG/PC) searches the DRIVE-CLiQ bus for connected objects. In the sample project, the PG/PC finds two drives.

6. Select the entry "Servo" from the list "Default setting for all components".

The drive in the project example is therefore used as servo control.

![Automatic configuration drive selection window]
7. Click on button "Create".

The automatic configuration process commences. When the process has been completed, a window with the message “Automatic configuration is complete” opens.

![Automatic Configuration](image)

Figure 6-5 Automatic configuration, stay online

---

**Note**

The above message appears because two drives are integrated in the training case. For our example configuration, however, we only put one drive into operation.

---

8. Click on the button "Stay ONLINE."
6.2 Configuring the Motor Module

The Control Unit has detected the connected Motor Module and the SMI motor during the automatic configuration process. The device data have been transferred to the Control Unit. The Control Unit has automatically entered the correct device data into the parameters required to operate the components.

The sample project is now ready to commission.
6.3 Special issues with the SINAMICS S120 training case

If you use the SINAMICS S120 training case (which is customary with SITRAIN), as in the example case, pay attention to the following special issues:

Motor used in the example configuration

In this example, we only put the motor with the DRIVE-CLiQ interface into operation. The second motor (with incremental encoder) is ignored.

Define infeed operating message

Note

The settings explained below refer exclusively to the example case. If you have already taken data from an earlier project, only checking the parameter settings described below will suffice. In this regard, see also the note "Online/offline comparison" in section Configuring the drive unit (Page 29).

So that you can commission the drive, you will need to define the signal source for the "Operating message of the infeed". In this example, we permanently set this signal to "1."

1. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP".
2. In the project navigator, click on the "+" symbol before drive "SERVO_02."
3. Double-click on the entry "Expert list."
4. Scroll to the right through the expert list to parameter p0864.

Figure 6-6  Expert list
5. There, click on the "0" button in the expert list.
   The following configuration dialog is opened:

   ![Configuration Dialog](image)

   **Figure 6-7 Infeed operation**

6. Click on row "1" and then click on "OK".

7. Go to the menu items "Project > Save" to save the example project.
Device supply voltage

You must reduce the device supply voltage so that you can commission the drive.

1. Scroll through the expert list of the drive to parameter p0210 (device supply voltage)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Data Type</th>
<th>Parameter text</th>
<th>Online value SERVO_02</th>
<th>Unit</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>p0210</td>
<td>Integer</td>
<td>Drive unit line supply voltage</td>
<td>600</td>
<td>V</td>
<td>Read</td>
</tr>
</tbody>
</table>

2. In the "Online value SERVO_02", overwrite the value "600" with "300"

3. Go to the menu items "Project > Save" to save the example project.
Commissioning a drive

The control panel allows you to perform basic tasks for operating, monitoring, and testing the drive. For operation, the symbols [START], [STOP], and [TIP], and various diagnostic functions are available.

You can find more information about these functions in the SINAMICS S120 Drive Functions Function Manual.

ON/OFF enable

1. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP".
2. In the project navigator, click on the "+" symbol before drive “SERVO_02.”
3. Double-click on the entry "Expert list."
4. Scroll to the right through the expert list to parameter p0840 for the ON/OFF signal.

Figure 7-1 On/off signal
5. There, click on the "0" button.

The configuration dialog for the ON/OFF signal is opened:

![Configuration dialog](image)

Figure 7-2 On/off configuration

6. Click on row "1" and then click on "OK".
Commission with the control panel

1. Double-click on the entries "S120_CU320_2_DP" > "Drives" > "SERVO_02" > "Commissioning" > "Control Panel" in the project navigator.

   ![Project example](image)

   Figure 7-3 Calling up the control panel

   The control panel is opened.

   ![Control panel](image)

   Figure 7-4 Control panel displayed

2. Click on button "Assume control priority!".
The "Assume control priority" window opens.

![Assume Control Priority Window](image1)

**Figure 7-5** Assuming control priority

3. Click on button "Safety notes".

The "Safety notes" window opens.

![Safety Notes Window](image2)

**Figure 7-6** Safety instructions

4. Read and take note of the safety notes and then close the window.

5. In the "Assume control priority" window, click on button "Accept".

The window is closed and the control panel is activated.

![Control Panel Motor Enable Signal](image3)

**Figure 7-7** Control panel motor enable signal
6. Activate the check box "Enable signals".
   The symbols [ ] and [ ] are active.

7. Enter a suitable speed for the motor in input field "n = ", e.g. "1,000."

![Control panel motor running](image)

8. Click on the symbol [ ].
   The motor accelerates to the selected example speed of 1000 rpm. The "Enables available" LED lights up green [ ].

---

**Switching off the drive**

1. To switch-off the motor, click on the [ ] symbol.
   The drive coasts to a standstill.

2. Click on the "Give up control priority!" button to return the control priority.

3. Confirm the following "Return control priority" prompt with "Yes."

4. Go to the menu items "Project > Disconnect from target system" to end the communication between the PG/PC and the Control Unit.

5. Go to the menu items "Project > Save" to save the example project to the local hard disk of the PG/PC.

---

Figure 7-8   Control panel motor running
## Appendix A

### A.1 List of important alarms and faults

**Axxxxx:** Alarm  
**Fyyyyy:** Fault

<table>
<thead>
<tr>
<th>Number</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| F07085 | Control parameters were compulsorily changed for the following reasons:  
- They exceeded dynamic limits due to different parameters.  
- They are not applicable because of properties of the detected hardware that are not present.  
  - Fault value (r0949, interpret as decimal): Changed parameter number.  
  - 340: The automatic calculation of the motor and control parameters was performed (p0340 = 1), because the vector control was later activated as a configuration (r0108.2).  
| | Not necessary. No parameter change is necessary as the parameters have already been limited to a reasonable level. |
| F07802 | Infeed or drive does not reply a 'ready' after an internal actuation command.  
- Monitoring time too short.  
- DC link voltage not available.  
- Associated infeed or drive of the reporting components defective.  
- Supply voltage incorrectly set. |  
| | - Extend monitoring time (p0857).  
- Ensure the DC link voltage. Check the DC link voltage. Enable the infeed.  
- Replace associated infeed or drive of the reporting components.  
- Check settings of the supply voltage (p0210). |
### A.1 List of important alarms and faults

<table>
<thead>
<tr>
<th>Number</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| F07840 | The "Infeed operation" signal is not available, though the enables for the drive have already been pending for longer than the parameterized monitoring time (p0857). Infeed not in operation. Interconnection of the binector input for the 'ready' signal is incorrect or missing (p0864). Infeed is currently identifying the network. | - Put infeed into operation.  
- Check the interconnection of the binector input for the "infeed operation" signal (p0864).  
- Extend monitoring time (p0857).  
- Wait for completion of the infeed network identification. |
| A08526 | No cyclic connection to the control is available.                     | Establish a cyclic connection and activate the control with cyclic operation. On PROFINET, check the parameters "Name of station" and "IP of station" (r61000, r61001). If a CBE20 is inserted and PROFIBUS should communicate through process data interface 1, then this has to be parameterized with the STARTER commissioning tool or directly through p8839. |
A.2 Restoring factory settings

In rare cases, it may be necessary to revert the target device (the training case) back to factory settings. The simulated drive in the training case thus obtains a defined state once again and you can then restart the configuration on a secure basis. Factory settings can only be reached in online mode.

Procedure

1. Go to the menu items "Project > Connect to selected target devices" to switch to online mode.

   The window "Target Device Selection" opens and lists the configured drive units.

2. Activate the "DEVICE" option.
3. Activate the check box "S120_CU320_2_DP", and click on "OK."

The PG/PC establishes the link to the Control Unit. It then performs an "Online/offline comparison". The result is displayed in the following dialog "Online/offline comparison". Example:

![Online/offline comparison](image)

4. Click on the "Close" button.
5. Select the drive object "S120_CU320_2_DP" in the project navigator.
6. With the right mouse button, select the shortcut menu "Target device > Restore factory settings."
7. Confirm the query with "OK".

The PG/PC sets the drive parameters to their factory settings.

The new status is automatically transferred to the Control Unit memory card using the function "Copy RAM to ROM".
8. Select the drive unit in the project navigator and go to the shortcut menu "Target device > Copy RAM to ROM."

The factory settings have now been restored: the drive is in a defined basic state.
A.3 Documentation overview

### SINAMICS documentation overview

**General documentation / catalogs**

- **SINAMICS G110**
  - D11 1 Converter chassis units
  - 0.12 kW to 3 kW

- **SINAMICS G130**
  - D11 1 Converter chassis units

- **SINAMICS S120**
  - PM21 SIMOTION, SINAMICS S120 and Motors for Production Machines

- **SINAMICS S150**
  - D21 3 SINAMICS S120 Chassis Format Units and Cabinet Modules

**Manufacturer / service documentation**

- **SINAMICS G110**
  - Getting Started Operating Instructions List Manual

- **SINAMICS G120**
  - Getting Started Operating Instructions Hardware Installation Manual

- **SINAMICS G120C**
  - Getting Started Operating Instructions Hardware Installation Manual

- **SINAMICS G130**
  - Operating Instructions List Manual

- **SINAMICS G150**
  - Operating Instructions List Manual

- **SINAMICS GM150**
  - Operating Instructions List Manual

  SM120 / SM150 GL150 SL150

**Manufacturer / service documentation**

- **SINAMICS S110**

- **SINAMICS S120**
  - Getting Started Commissioning Manual

- **SINAMICS S120**
  - Equipment Manual for Control Units and Supplementary Components

- **SINAMICS S150**
  - Operating Instructions List Manual

  Manual for AC Drives

**Manufacturer / service documentation**

- **SINAMICS Motors**
  - SINAMICS Manual Collection

- **Motors**
  - Configuration Manuals

- **Configuration Manual**
  - EM Guidelines